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About this Guide

This guide provides all the information that you need to prepare for the 
Logic Pro 9 exam to earn Apple Certified Pro Level Two certification. From 
this guide you can:

• Learn about Apple Certification.

• Find out how to take the exam.

• Locate resources to help you prepare for the exam.

• Review the range of objectives that the exam may cover.

• Get a feel for the type of questions that appear on the exam.

Becoming an Apple Certified Pro
The Apple Training & Certification program is designed to keep you at the 
fore front of Apple technology. Apple Certification creates a benchmark to 
demonstrate your proficiency in specific Apple technologies and gives you 
a competitive edge in today’s evolving job market.

What is an Apple Certified Pro?
An Apple Certified Pro is a user who has reached the highest skill level in 
the use and operation of Apple’s Pro Applications as attested to by Apple.

How do I become an Apple Certified Pro?
To become an Apple Certified Pro, you must pass an online exam 
administered at an Apple Authorized Training Center (AATC). Level One 
exams are administered at the end of specific courses. 

If you prefer to learn on your own or believe you already have the 
necessary skills in your chosen application, you may take an exam at an 
AATC for a fee. 

Level One attests to basic operational knowledge. Level Two attests to a 
deeper understanding of an application. Class attendance is 
recommended, but not required. To be eligible to earn Level Two Logic 9 
certification, you must first earn Logic 9 Level One certification.

What are the benefits of being an Apple Certified Pro?
Beside differentiating you as a skilled user of a specific Apple application, 
becoming an Apple Certified Pro allows you to leverage the power of the 
Apple brand. When you pass an Apple Certification exam, you receive an 
email with a PDF copy of your Apple certificate, along with instructions on 
how to order a printed and/or a printed and framed certificate. The email

includes LinkedIn, Facebook, and Twitter icons to make it easy for you to 
share your certification news with your networks on these sites.

You also receive a login for the Apple Certification Records System, where 
you can:

• Update your profile information and opt in to display your Apple
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• Review your certification progress.

• Download your certification logo(s) to use on business cards, resumes,

• Provide access to employers to verify your certifications.

Exam Details

The Logic Pro 9 Level Two exam is a computer-based test offered at Apple 
Authorized Training Centers (AATCs). To find the closest AATC, please visit 
training.apple.com/locations.

Many AATCs schedule Certification Exam Sessions at training.apple.com/
schedule. If you don't see a session scheduled at your nearest AATC, you 
can contact the AATC and they will often schedule a session. Please note 
that all AATCs offer all Mac OS X and Pro Apps exams, even if they don’t 
offer the corresponding course.

The Logic Pro 9 Level Two exam details are as follows:

• Exam number: 9L0-839

• Number of test questions: approximately 56 technical, five

• The exam uses a random pool of multiple-choice, fill-in-the-blank and

• Passing score: 80% (scores are not rounded; you must earn a score of 
80% or higher to pass the exam)

• Details on exam scoring appear at training.apple.com/certification/faq

• Exam duration: One hour thirty minutes exams are available in other 
languages, please visit training.apple.com/certification/localized.

The exam timer does not start until you view the first technical question. 
You may not access any resources or references during the exam.

Recommended Exam Preparation
We recommend the following exam preparation strategies:

• Gain experience with the application.

• Learn from experts: Logic 301: Advanced Music Production in Logic Pro

• Study the Apple Pro Training Series book “Logic Pro 9 Advanced Music 
Production” by David Dvorin with Robert Brock (ISBN 0-321-64745-9).

• Review the optional study materials.

• Review the objectives and sample questions in this guide.

Gain Experience with the Application
Nothing can substitute for time spent learning the technology first hand. 
After you read the book and/or take the class, spend time increasing your 
familiarity with the software on your own to ensure your success on the 
certification exam.
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Learn from Experts
Apple Authorized Training Centers (AATCs) offer classes where you can 
learn hands-on with the technology and benefit from the expertise of 
Apple Certified Trainers and your peers. Visit the Apple Training & 
Certification website to find course offerings at nearby AATCs.

Study the Apple Pro Training Series Book
Apple Pro Training Series books are the basis for the Certification exams. 
The book for this exam is Apple Pro Training Series book “Logic Pro 9 
Advanced Music Production” by David Dvorin with Robert Brock (ISBN 
0-321-64745-9). You can purchase the book at peachpit.com (click here for 
a 30% discount code). Creative Edge, an on-demand digital library, offers 
subscription access to the Apple Pro Training Series, as well as thousands of 
other reference videos and books. You can also purchase an ebook version 
from the iBookstore.

Review the Optional Study Materials
• Review the appropriate sections of the User Manuals at: 

documentation.apple.com. You can also launch the Logic Pro 
documentation by choosing Help > Logic Pro User Manual when 
Logic Pro is launched. Information on new features is available by 
choosing Help > New Features when Logic Pro is launched.

• Many online resources allow you to ask questions and learn tips. To 
other online materials, visit www.apple.com/logicpro/resources/.

• For information on the Apple Pro Training Program, visit

• To provide comments and feedback to Apple about Logic Pro, visit

• Read the late breaking news at www.apple.com/support/manuals/.

• Many third-party manufacturers create reference, troubleshooting and 
provide you with dozens of options.

• If you have any questions, you can post them to the Logic Pro

Lesson One objectives
Upon completion of Lesson One, “Speeding Up Your Workflow” in “Logic 
Pro 9 Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Create and save their own custom template
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• Customize existing screensets for session needs

• Know the advantages and disadvantages of locking screensets

• Assign key commands to speed up a workflow

• Access needed tools quickly and efficiently

• Back up and share your settings

Lesson One review questions
After completing Lesson One, you should be able to answer the following 
questions.

1. What are project templates?

2. What are some of the ways you can customize a project file?

3. What is the advantage of an unlocked screenset?

4. Identify two strategies for creating key commands that help 
you remember them.

5. Are all key commands accessible via menus?

6. In what ways can you quickly access the Tool menus?

7. In what ways can you back up and share your settings?

Answers

1. Project templates are premade project files containing 
various configurations specific to certain session tasks, such as 
composing and mixing.

2. Project files can be customized by adding buttons to the 
toolbar and Transport bar and by maximizing various areas of 
the workspace.

3. An unlocked screenset can be advantageous during the 
editing stage because it allows a dynamic view of the current 
data.

4. Assign a key command only if you find yourself performing 
menu command often. Assign keys that provide a clue to the 
function of a command, such as a key with a graphic 
representation or the first letter of the function.

5. No. Some useful functions are accessible only via key 
command, indicated by a bullet preceding the name in the 
Key Commands window.

6. You can access the Tool menus quickly by using alternate 
tools, using the  key to display the Tool menu at the pointer 
location, and using a two-button mouse.

7. Custom key commands, plug-in settings, and channel strip 
settings can be backed up to traditional storage media, as 
well as to a Bonjour account on a local network or a 
MobileMe account accessed via an Internet connection.
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Lesson Two objectives

Upon completion of Lesson Two, “Working with Time and Pitch” in “Logic 
Pro 9 Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Use the Apple Loops Utility to create their own Apple Loops

• Use the Time and Pitch Machine to create a harmonized part

• Use the Pitch Correction effect to intonate an audio track

• Manipulate the phrasing and feel of audio tracks using the Flex tool

• Quantize audio regions with flex time to change the feel or tighten the 
timing

• Conform the timing of one region to that of another by creating 
custom groove templates

• Use speed fades to simulate turntable or tape machine effects

• Use varispeed to smoothly change the tempo of the entire project

• Match a project’s time grid to a freely played recording for further 
editing and development

Lesson Two review questions
After completing Lesson Two, you should be able to answer the following 
questions.

1. Which important aspect of an audio file determines how the 
Apple Loops Utility manipulates timing?

2. Which two attributes of a Logic project determine how Apple 
Loops are conformed?

3. Which offline Logic feature is used to exercise detailed control 
over an audio file’s pitch (in addition to its timing), including 
the natural resonances (formants) of a given sound?

4. What works on audio input, dynamically intonating a 
performance in real time by aligning it to a pitch quantization 
grid?

5. Flex time uses what as a point of reference when time 
compressing or expanding?

6. When making region-based time adjustments on audio like 
quantizing, flex time uses what to adjust the timing in 
relation to the time grid?

7. Flex time transient markers can only be edited where?

8. How are speed fades created?

9. True or false: Varispeed can alter both pitch and time of an 
entire project.

10. Which global track lets you graphically align Logic’s time grid 
to a rubato part?
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11. True or false: Both audio and MIDI regions can be beat-
mapped.

Answers

1. Transients. They must be defined accurately through 
automatic and manual means to achieve the best results 
when creating Apple Loops.

2. The project’s key and tempo determine how Apple Loops are 
conformed.

3. The Time and Pitch Machine provides detailed control over 
pitch and time, and it uses pitch shifting to preserve the 
natural resonances of a given sound.

4. The Pitch Correction plug-in intonates audio input in real 
time, dynamically intonating a performance by aligning it to a 
pitch quantization grid.

5. Flex markers are used as points of reference for time 
manipulation, and they may be created independently of, or 
on top of transient markers.

6. When making region-based time adjustments like 
quantizing, flex time uses both flex markers and transient 
markers as timing references aligning to Logic’s time grid.

7. Flex time transient markers can only be edited in the Sample 
Editor.

8. Speed fades are created with the Fade tool and specified 
within the Region Parameter box.

9. True. Varispeed can alter both pitch and time of an entire 
project (including MIDI regions).

10. The Beat Mapping track allows the accurate rescaling of the 
time grid to a rubato part.

11. True. Both audio and MIDI regions can be used as the basis 
for beat mapping.

Lesson Three objectives
Upon competion of Lesson Three, “Synthesis with the ES2 Synthesizer” in 
“Logic Pro 9 Advanced Music Production,” you should be able to complete 
the following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Trace the signal flow through the ES2

• Select, combine, and blend multiple waveforms from all three 
oscillators to generate interesting sounds

• Shape the generated sound with the filters

• Modulate parameters with low-frequency oscillators and envelopes

• Add additional processing through output parameters
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Lesson Three review questions
After completing Lesson Three, you should be able to answer the following 
questions.

1. Which direction does signal flow in the ES2?

2. Each of the three oscillators in ES2 offers what in addition to 
analog-style waveforms and modulation options?

3. When in FM mode, Oscillator 1 acts as the carrier, and 
Oscillator 2 acts as what?

4. When in Ring Modulation mode, Oscillator 2 acts as the 
carrier, and Oscillator 1 acts as the what?

5. When using oscillator synchronization, which oscillator is the 
master?

6. How can the ES2 filters be configured?

7. In the ES2, modulation is assigned where?

8. The ES2 vector envelope can be assigned to what two 
targets?

Answers

1. Signal flow moves from left to right, which helps with 
understanding the instrument as well as locating controls.

2. Each oscillator offers 100 Digiwaves.

3. Oscillator 1 acts as the carrier, and Oscillator 2 acts as the 
modulation source.

4. Oscillator 2 acts as the carrier, and Oscillator 1 acts as the 
modulation source.

5. Oscillator 1 is the master when using oscillator 
synchronization.

6. The filters can be configured in either series or parallel.

7. Modulation is assigned within slots of the modulation router. 

8. The ES2 vector envelope can be assigned to Mix (Triangle) 
and the X-Y (Planar) pad.

Lesson Four objectives
Upon completion of Lesson Four, “Sampling with the EXS24 mkII” in “Logic 
Pro 9 Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Build new sampler instruments from audio regions

• Assign pitch mapping and tuning to zones

• Create loop points for sustaining sounds
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• Use groups to assign common parameters to multiple zones

• Use filters and modulation to change the character of sampled 

• Route output of specific groups for individual processing

Lesson Four review questions
After completing Lesson Four, you should be able to answer the following 
questions.

1. Individual samples are referenced and mapped within what?

2. What contains the settings for how a sample will be played 
back, including key ranges?

3. Which tuning parameter in the EXS24 Instrument Editor 
would be used to tune by cents, Coarse or Fine?

4. Are loop points set within zones or groups?

5. What parameter in the EXS24 Instrument Editor is used to 
smooth out transitions between the end points and start 
points of a loop?

6. How are groups used in the EXS24 Instrument Editor?

7. Are filter and envelope offsets set within zones or groups?

8. What do multi-output instruments do?

Answers

1. Samples are mapped within sampler instruments.

2. Zones contain the settings for how a sample will be played 
back, including key range.

3. The Fine parameter is used to tune by cents.

4. Loop points are set within zones, as they refer to specific 
samples.
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5. The Xfade parameter allows you to assign a crossfade 
between the end and start points of a loop, making it 
smoother.

6. Groups are used to assign common parameters to multiple 
zones.

7. Filter and envelope offsets are set within groups.

8. Multi-output instruments (such as Ultrabeat and EXS24 mkII) 
can route individual sounds to separate channel strips for 
isolation or further processing.

Lesson Five objectives
Upon completion of Lesson Five, “Sound Design with Sculpture” in “Logic 
Pro 9 Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Explore different material characteristics on which to base your sound

• Apply different objects to select how the material is played

• Process the sound using the Waveshaper and Body EQ

• Morph between variances of the sound using the Morph Pad

• Record your movements in the Morph Pad to use as a modulation

Lesson Five review questions
After completing Lesson Five, you should be able to answer the following 
questions.

1. What is the basis for sound generation in Sculpture?

2. What controls the basic material of the string?

3. What does an object do?

4. What is used to control where each object interacts with the 
string?

5. What is used to sense vibrations along the string?

6. Besides the sound-generation and modulation sections in 
Sculpture, what other components are used to further 
process the sound?

7. Which modulation control enables you to program smooth 
transitions between various parameter states?

Answers

1. Sculpture utilizes a string acted upon by objects as the basis 
for sound generation.

2. The Material Pad controls the damping and stiffness of the 
string.
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3. The objects determine how the string is excited or disturbed 
(how it is played).

4. The object sliders can be positioned anywhere along the 
length of string by adjusting within the Pickup display.

5. The pickups are used to sense vibrations along the string, 
similar to an electric guitar.

6. Components such as the Waveshaper, Body EQ, and Delay 
allow you to further process the instrument in interesting 
ways.

7. The Morph Pad enables you to smoothly move from various 
states of control settings.

Lesson Six objectives

Upon completion of Lesson Six, “Building Drum Sounds with Ultrabeat” in 
“Logic Pro 9 Advanced Music Production,” you should be able to complete 
the following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Create drum sounds using Ultrabeat’s synthesis and sample playback 
sound generators

• Modulate targets using envelopes and LFOs as sources

• Use the filter and distortion circuit to process drum sounds

• Automate parameters with step sequencing

Lesson Six review questions
After completing Lesson Six, you should be able to answer the following 
questions.

1. Oscillator 1 offers what modes of sound generation?

2. Oscillator 2 offers what modes of sound generation?

3. Source modulation routings appear in what color on the 
interface?

4. Via modulation routings appear in what color on the 
interface?

5. Routing to the filter and distortion circuit is done by enabling 
what?

6. In order to define the target parameter for Step mode, you 
need to do what?

Answers

1. Oscillator 1 offers phase oscillator and frequency modulation 
synthesis (as well as side chain input).

2. Oscillator 2 offers phase oscillator, sample playback, and 
physical modeling.
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3. Source modulation routings appear in blue.

4. Via modulation routings appear in green.

5. You can route to the filter and distortion circuit by enabling 
the Signal Flow buttons, located around each oscillator’s 
Volume knob.

6. You need to click a control first in order to define it as the 
target parameter for Step mode.

Lesson Seven objectives
Upon completion of Lesson Seven, “Working with the Arrangement” in 
“Logic Pro 9 Advanced Music Production,” you should be able to complete 
the following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Use specialized playback commands for editing tasks

• Create and edit markers using a variety of techniques

• Understand playback and transport hierarchy

• Perform global edits to add and subtract song sections

• Navigate via markers using a variety of techniques

• Rearrange song sections using folders

• Use locators to skip over entire sections in the project

• Learn zoom techniques to visualize and edit material

Lesson Seven review questions
After completing Lesson Seven, you should be able to answer the 
following questions.

1. How do markers aid in a production?

2. How is changing the text and color of markers useful in a 
production?

3. Where are markers accessed?

4. How can you initiate playback from the bar number displayed 
on the far left side of Arrange area?

5. How are locators set?

6. Where do you configure playback hierarchy?

7. How can you insert or delete measures across all tracks of a 
project (including global tracks) at once?

8. How can you compartmentalize large groups of regions for 
quick, simple rearranging
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Answers

1. Markers can designate section material or serve as navigation 
points.

2. Changing the appearance of markers (including production 
notes) helps you easily identify and navigate to sections 
within the arrangement.

3. Markers can be accessed in the Bar ruler, Marker track, or 
Marker List. 

4. Use the Play From Left Window Edge key command.

5. Locators can quickly be set by dragging within the Bar ruler 
or by creating cycle areas for any region, event, or marker.

6. Hold the Play button in the Transport area.

7. Set locators around the measure to be added or deleted and 
then choose Cut/Insert Time commands from the Edit menu.

8. Pack all regions of a song into a folder. The folder can then be 
divided into song sections and rearranged.

Lesson Eight objectives
Upon completion of Lesson Eight, “Advanced Audio Editing” in “Logic Pro 9 
Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Apply crossfades to multiple regions simultaneously

• Draw out clicks in audio files

• Create a composite take using take folders

• Edit multiple tracks simultaneously with groups

• Use phase-locked editing to edit and quantize drums

• Replace bad drum hits with good ones using transient detection 
techniques

• Use drum replacement/doubling to replace recorded drum sounds 
with samples

• Use Soundtrack Pro as an external audio editor

Lesson Eight review questions
After completing Lesson Eight, you should be able to answer the following 
questions.

1. How can you smooth transitions between edited regions?

2. How can you eliminate clicks and pops within an audio file?

3. How can you create new parts from existing material?

4. How can you edit multiple tracks of a drum recording?
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5. How can you quantize an acoustically recorded drum kit?

6. How can you quickly replace bad sections of audio with good 
sections?

7. What features exist within Soundtrack Pro that are not found 
in Logic?

8. How do you move audio edited in Soundtrack Pro back to 
Logic?

9. How can you replace the sound of a drum instrument?

Answers

1. Smooth transitions with crossfades. To accomplish this for 
large numbers of regions, set crossfade parameters in the 
Region Parameter box.

2. In the Sample Editor, zoom in on the waveform and draw out 
the click with the Pencil tool.

3. Pack a take folder of selected regions and then use Quick 
Swipe Comping to edit the parts together.

4. Using Mixer groups, create an Edit group with phase-locked 
editing enabled.

5. Assign drum tracks to a phase-locked edit group and then 
enable quantization parameters in the Region Parameter box.

6. Cut and paste material using marquee selections that are 
precisely tuned using the Snap to Transient commands.

7. Actions, Paste Mix, and Frequency Spectrum view.

8. Save over the exported audio file, making sure the file type 
and bit depth match the original.

9. Apply the Drum Replacement/Doubling command to convert 
audio tracks into a MIDI track that will trigger sampled 
instruments.

Lesson Nine objectives
Upon completion of Lesson Nine, “Advanced MIDI Editing” in “Logic Pro 9 
Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Utilize aliases to repeat performances in other parts of the project

• Edit regions by applying playback parameters

• Use quantization techniques to change the rhythmic feel

• Use specialized selection techniques to edit MIDI events

• Modify MIDI data using the Transform window

• Split multipart MIDI regions into individual parts for editing
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Lesson Nine review questions
After completing Lesson Nine, you should be able to answer the following 
questions.

1. How are aliases used?

2. What does the Region Parameter box do?

3. How can you quickly modify the timing a MIDI region?

4. What are the Q-Velocity and Q-Length parameters used for?

5. What does the Invert Selection command do in a MIDI editor?

6. What does the Select Equal Subpositions command do in a 
MIDI editor?

7. Where can you access the transform functions?

8. How are the transform functions useful?

9. What does Separate by MIDI Events do?

Answers

1. Aliases are used for duplicating material that needs to 
automatically update when the original is edited.

2. The Region Parameter box allows real-time control over 
various playback parameters, enabling you to transpose and 
adjust the feel of events in a MIDI region.

3. Select a Quantize setting to determine the timing grid that 
notes will be aligned to. Use the Q-Swing and Q-Strength to 
further refine how the notes are placed in relationship to the 
grid.

4. Q-Velocity and Q-Length can be used to conform MIDI notes 
to the length and velocity values defined in a quantization 
template that is selected using the Quantize parameter.

5. The Invert Selection command selects all regions (in the 
Arrange area) or events (in a MIDI editor) that are not 
currently selected and deselects any regions or events that 
are selected.

6. The Select Equal Subpositions command selects all regions or 
events with a similar bar or beat relationship to the selection.

7. The transform functions can be accessed via the main 
Window menu, or via the Functions > Transform menu in all 
MIDI editors.

8. The transform functions contain many helpful operations for 
processing MIDI data, such as humanizing performances.

9. Separate by MIDI Events separates combined parts recorded 
in a single MIDI region into individual regions for further 
editing.
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Lesson Ten objectives

Upon completion of Lesson Ten, “Managing the Mix” in “Logic Pro 9 
Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Import channel strips, automation, and audio content from other

• Use Mixer views to navigate in a mix

• Create production notes and save them with your project

• Control the balance and imaging width of a stereo signal

• Create a dedicated alternative Mixer view to access frequently used 
channel strips

• Change the plug-in order in a signal chain

• Create channel groups to link the controls of multiple channels

Lesson Ten review questions
After completing Lesson Ten, you should be able to answer the following 
questions.

1. What track data can you import from one project to another?

2. Explain the difference between the Mixer’s Arrange, All, and 
Single view modes.

3. Notes can be created for both the project and what?

4. Which insert plug-in aids in accurate stereo placement within 
a mix?

5. A plug-in’s Show Channel Strip and Show Insert menus allow 
what?

6. Which tool allows you to change the insert order, thereby 
affecting signal flow?

7. How do you link the controls of multiple channels while 
mixing?

8. How do you temporarily disengage a group?

Answers

1. You can import track content, channel strip configuration 
(including plug-ins and routings), and automation data from 
one project into another.

2. The Mixer’s Arrange view adapts to the Arrange area’s track 
list, and vice versa. The All view mode displays all the 
channels existing in a project’s Environment, and it can be 
used to create an alternative mixer with commonly accessed 
channels. The Single view displays the entire signal flow from 
a selected channel, including send channels and output.

3. Notes can be created for both the project and tracks.
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4. Stereo tracks can be accurately balanced and their images 
adjusted by means of the Direction Mixer plug-in.

5. A plug-in’s Show Channel Strip and Show Insert menus allow 
navigation from plug-in to plug-in within the same window, 
making it easier to copy and paste settings between plug-ins.

6. The Hand tool allows you to change the insert order by 
dragging and dropping plug-ins within a single channel, or 
from channel to channel.

7. Use groups to link the controls of multiple channels while 
mixing.

8. Engage the group clutch (press Command-G or, in the Mixer’s 
menu bar, choose Options > Group Clutch).

Lesson Eleven objectives

Upon completion of Lesson Eleven, “Controlling Signal Flow” in “Logic Pro 9 
Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Create submixes for processing multiple channels

• Create a headphone mix

• Use plug-in side chains

• Use parallel compression while maintaining stereo placement

• Incorporate external effects processors into Logic’s Mixer

• Bounce both regions and tracks in place

Lesson Eleven review questions
After completing Lesson Eleven, you should be able to answer the 
following questions:

1. What is the most efficient way to apply effects processing to 
multiple channels at once?

2. Side chaining plug-ins allows you to do what?

3. Sends can be configured in what three ways?

4. How do you insert an external effects processor into the 
signal chain?

5. When bouncing regions or tracks in place, a channel’s audio 
signal can be rendered to a new audio file with and without 
what?

Answers

1. Use aux channels as submixes to apply effects processing to 
multiple channels.
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2. Side chaining plug-ins allows you to control an effect on one 
channel by the signal from another channel.

3. Sends can be configured post-fader, pre-fader, and post-pan 
(and fader).

4. Insert external effects processors into the signal chain using 
the I/O plug-in.

5. When bouncing regions or tracks in place, a channel’s audio 
signal can be rendered to a new audio file with or without 
plug-ins, effect tail, and volume and pan automation.

Lesson Twelve objectives
Upon completion of Lesson Twelve, “Controlling the Mix” in “Logic Pro 9 
Advanced Music Production,” you should be able to complete the 
following tasks. Items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Automate an aux channel

• Copy automation data between tracks

• Scale automation

• Apply automation to multiple tracks at once

• Map your MIDI controller to Logic’s controls

Lesson Twelve review questions
After completing Lesson Twelve, you should be able to answer the 
following questions.

1. How can you automate an aux channel?

2. Snap automation is enabled where?

3. How is automation data scaled?

4. What must be done in order to apply automation to multiple 
tracks at once?

5. Where do you assign MIDI controls to Logic’s transport?

6. How do you assign MIDI controllers to plug-in parameters 
and channel controls?

Answers

1. Aux channels are automated by first adding them to the 
Arrange window with the Create Arrange Tracks for Selected 
Channel Strips command.

2. Snap automation is enabled in the Arrange area’s Snap menu.

3. You can scale automation data by Command-dragging the 
value fader for the automation parameter.
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4. In order to apply automation to multiple tracks at once, the 
channels must be grouped.

5. MIDI controls are assigned to Logic’s transport in the Key 
Commands window.

6. MIDI controllers are assigned to plug-in parameters and 
channel controls in the Controller Assignments window.

Lesson Thirteen objectives

The Logic 301 class does not cover the material in Lesson 13. None of the 
material in this chapter is included in the end user certification exam. 
However, the material in this chapter is included in the Trainer exam.

Lesson Fourteen objectives
Upon completion of Lesson Fourteen, “MIDI Processing in the 
Environment” in “Logic Pro 9 Advanced Music Production,” you should be 
able to complete the following tasks. Items from this lesson are included in 
the pool of exam questions, drawn randomly from the following objectives:

• Use and create layers in the Environment

• Understand MIDI signal flow within the Environment

• Create objects for processing MIDI data

• Create serial and parallel routing for complex real-time processing

• Trigger MIDI regions with touch tracks objects

Lesson Fourteen review questions
After completing Lesson Fourteen, you should be able to answer the 
following questions:

1. How are layers used within the Environment?

2. What does the Physical Input object represent?

3. What does the keyboard object do?

4. What does the monitor object do?

5. What does the Sequencer Input object represent?

6. How do you cable an object from one layer to another?

7. What does an arpeggiator object do?

8. What does a chord memorizer object do?

9. What does a delay line object do?

10. What does a transformer object do?

11. What does a cable switcher object do?

12. What does a touch tracks object do?
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Answers

1. Layers are used to organize objects of like type or function 
within the Environment.

2. The Physical Input object represents the ports of your MIDI 
interface or MIDI controller (with direct MIDI­−­−to­−­−USB 
connection).

3. The keyboard object displays incoming MIDI notes as well as 
generating new ones from its output.

4. Monitor objects display MIDI events passing from their input 
to their output in a list form.

5. The Sequencer Input object represents the connection to 
Logic’s sequencer.

6. Cabling across layers is performed by Option­−­−clicking the 
output of the object and selecting the input object from the 
menu.

7. An arpeggiator object arpeggiates harmonic input (chords), 
outputting each note individually in a selectable pattern.

8. Chord memorizer objects map a single note to a set of up to 
12 user­−­−selected notes.

9. Delay line objects repeat MIDI events passing through them, 
achieving a result similar to that of a delay processor creating 
echoes from audio signals.

10. Transformer objects primarily change one type of MIDI data 
to another. They can also act as a MIDI filter, track automation 
splitter, SysEx mapper, and condition splitter.

11. Cable switcher objects are used to manually direct the signal 
flow out of multiple outputs.

12. Touch tracks objects allow you to trigger MIDI regions or 
folders by playing single notes.

Lesson Fifteen, Sixteen, and Seventeen Objectives
The Logic 301 class does not cover the material in Lessons Fifteen, Sixteen 
and Seventeen. Material in these chapters is not included in the end user 
certification exam; the material in these chapters is included in the Trainer 
certification exam. However, many candidates seek certification to bolster 
their resume as a Logic consultant and the information in these lessons 
can help clients transition to Logic from another program.

Taking the Logic Pro 9 Level Two exam
The Logic Pro 9 Level Two certification exam must be taken at an Apple 
Authorized Training Center (AATC) in a proctored setting. To find the closest 
AATC, please visit training.apple.com/aatc.
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Many AATCs schedule "Certification Exam Sessions" at training.apple.com/
schedule. If you don't see a session scheduled, you can contact the AATC 
and they will often schedule one for you. Please note that all AATCS can 
offer all OS X and Pro Apps exams, even if they don’t offer the 
corresponding course.

Exam FAQs
Please visit training.apple.com/certification/faq for a list of Frequently 
Asked Questions. If you do not find the answer to your question, then 
email us. Please allow at least two business days for a response.
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